Sets the size of the blocks used to build a three-dimensional picture of your desktop.



Sets the speed at which the blocks build a three-dimensional picture of your desktop.



Shows the icons Windows uses for items on your desktop. To change the icon for a particular item, click the item, and then click
Change Icon.



Click this to change the icon for the selected desktop item.



Displays desktop icons using all the colors supported by your current display and your color-palette settings. Your monitor may
support a larger color palette than you are using. You can change your display-type and color-palette settings by using the
Settings tab.

Note Using all possible colors to display icons takes up more computer memory, and it may take Windows longer to refresh your
desktop if you are using a 486-based computer. If you want to improve performance, make sure this box is unchecked.



Displays the contents of a window as you move or size it. If this box is checked, you may see "trails" as you move a window.

To see only the window outline when you move a window, leave this box unchecked. Also leave this box unchecked if you want to
see what's behind a window as you move or size it.



Makes your screen fonts more readable by smoothing the jagged edges of large fonts. To use this option, you must have a video
card and monitor that supports 256-color. For best results, your video card and monitor should support high color (16-bit color).



Stretches a centered wallpaper so that it covers your entire screen. For this option to take effect, click the Background tab, and
then make sure Center is selected.

If you are using a 486-based computer and want to improve performance, leave this box unchecked.



Uses large icons to represent files, folders, and shortcuts on your desktop.

Large icons require more memory than smaller icons. If you notice a decrease in performance, leave this box unchecked.



Shows how much space on the selected drive is free and how much space is used by files. The files are represented by the
different compression methods used on them.



Provides information about the uncompressed size, compression ratio, and disk-space gain for files that are compressed using
UltraPack, HiPack, and standard compression.



Provides information about the uncompressed size, compression ratio, and the disk-space gain for files that are compressed
using UltraPack compression.

Note Although UltraPack generally provides better compression than HiPack, the compression ratio for HiPack may be higher
because the data that is currently HiPacked may compress better than the data that is currently UltraPacked. This can cause
HiPack to achieve a better compression ratio than UltraPack.



Provides information about the uncompressed size, compression ratio, and disk-space gain for files that are compressed using
HiPack compression.

Note Although UltraPack generally provides better compression than HiPack, the compression ratio for HiPack may be higher
because the data that is currently HiPacked may compress better than the data that is currently UltraPacked. This can cause
HiPack to achieve a better compression ratio than UltraPack.



Provides information about the uncompressed size, compression ratio, and disk-space gain for files that are compressed using
standard compression.



Provides information about the size, compression ratio, and disk-space gain for files that are uncompressed.

The compression ratio for these files typically is 1.00 to 1; and, since you don't gain disk space by leaving these files
uncompressed, the Gain column is always zero.



Describes how much free space you now have, the compression ratio used to estimate the remaining free space, and how much
free space was gained by compressing the drive.



When you compress your drive, you can store more files in a given amount of disk space. For example, when you compress a
drive, you can save more files within 10 KB of disk space than you can when the drive is not compressed.

This line shows the space gained by storing more files within the same disk space.



Shows the total uncompressed size of all the files on the drive, the average compression ratio used by the files, and the amount
of disk space you gained by compressing the drive.



Click this to recompress this drive. You might want to do this if you have changed or created files on this drive since it was last
recompressed.



Click this to upgrade this drive to DriveSpace 3 format.

By upgrading this drive, you can achieve better compression and increase its free space. Also, you must upgrade the drive if you
want to use Compression Agent to recompress it.



Click this to display more compression information about the drive, such as information about its host drive and the compressed
volume file.



Shows the progress Windows is making as it sorts and calculates the compression information for the drive.



Prevents the host drive from appearing on your system. If this option is checked, the host drive (and any files on it) do not appear
in Windows Explorer or My Computer. Also, you will not be able to use the free space on the host drive.

DriveSpace 3 requires at least 4 MB of free space on the host drive to manage you compressed drive. If you have less than 4
MB free, you might want to hide the host drive to keep the drives list from getting cluttered.

Even if you hide the host drive, you can still work with it from the MS-DOS prompt. It will also appear in the list of drives in the
DriveSpace window, where you can also work with it.



Click here to compress this drive.



Shows how much estimated free disk space you will have after you compress this drive.



Click this to create a new, empty, compressed drive using some or all of the free space on this drive. Windows will compress the
files you save to the new drive.



Shows how much estimated disk space you will gain by creating a new, empty, compressed drive.



Click this to run DriveSpace to create and work with compressed drives.



Shows how much disk space on this host drive is used and how much is free. The drive contains the compressed volume file for
one or more compressed drives.



Provides information about how much space is used by the compressed volume file for one or more compressed drives, how
much space is used by other files, and how much space is free on this host drive.

If you have more than one compressed drive, click the arrow, and then click the drive for which you want to view information.



Displays the address or URL (uniform resource locator) of the place on the Internet that the shortcut points to.



Click Contents to see a list of topics.



Help is available for each setting in this box. Click " at the top of the dialog box, and then click the setting or button you want
information about.



Welcome to Microsoft Plus! for Windows 95

Microsoft Plus! provides several features designed to enhance the look of Windows 95, and make it easier to maintain on 486
and Pentium computers.

Click a button to find out more about Microsoft Plus! features.

_| System Agent: For scheduling programs
I Enhanced disk compression: For creating more space on compressed drives
Desktop enhancements: For giving your desktop a new look
| Network and Internet features: For dialing into your computer and browsing the Internet

¥ To return to this screen from a topic, click the Back button.
¥ To get started using Plus!, click Help Topics, and then double-click the feature you're interested in.



System Agent
Click a button to find out more about using System Agent to monitor disk space and to schedule programs.
loverview of System Agent
Program scheduling
Low-disk-space reminders

Overview of System Agent

System Agent monitors your system and performs disk-maintenance tasks while your computer is turned on. It checks your disk
drives for available space, and starts programs that are scheduled to run at specific times.

If you want System Agent to continually monitor your system, leave your computer running, even when you are not using it. To
save power, you can turn off your monitor without affecting System Agent.



Program scheduling

You can use System Agent to schedule programs to run at the time you specify. When you set up Microsoft Plus!, Disk
Defragmenter, ScanDisk, and a low-disk-space notification are already scheduled to run at regular intervals. If you upgrade your
compressed drive to DriveSpace 3, Compression Agent, a program you can use to gain more disk space on a compressed drive,
is also scheduled.

Some programs can be customized to run the way you want them to. For example, although Disk Defragmenter is scheduled to
perform a full defragmentation daily, you can schedule it to consolidate only the free space on your disk at 11:00 Pm on the first
day of each month.

To schedule a program with System Agent, click the Start button, point to Programs, point to Accessories, point to System Tools,
and then click System Agent.
Tip
" If System Agent is already running, you can quickly open the System Agent window by double-clicking the System Agent
icon
3 on the taskbar.



Low-disk-space reminders

Because System Agent monitors your disk, it can display a reminder when a drive is getting full.

You can specify how much free space should be left on your drive before the reminder appears by clicking Low Disk Space
Notification in the System Agent window and then clicking Properties on the Program menu.



Enhanced disk compression

Microsoft Plus! offers new disk compression tools that can dramatically increase the amount of information you can store on your
disk drives.
I New features in DriveSpace 3
Compression Agent
Compressed drive information

New features in DriveSpace 3

Microsoft Plus! includes DriveSpace 3, an enhanced version of Windows 95 DriveSpace that supports the following new
compression features:

DriveSpace 3 compression, a new and improved compression technology for creating compressed drives.

The ability to upgrade compressed drives that were created using MS-DOS or Windows 95 DriveSpace, or MS-DOS
DoubleSpace, to the new DriveSpace 3 format.
" Support for compressed drives up to 2 gigabytes in size.
The ability to fine-tune compression for maximum disk space, maximum system speed, or a balance between speed and

space.

To use DriveSpace 3, click the Start button, point to Programs, point to Accessories, point to System Tools, and then click
DriveSpace.



Compression Agent

Microsoft Plus! includes Compression Agent, a program you can use to create more free space on a DriveSpace 3 compressed
drive. Once you have upgraded or compressed a drive by using DriveSpace 3, Compression Agent is scheduled in System
Agent to run at regular intervals. When Compression Agent runs, it recompresses the files on your drive using the compression
methods you specify.

You can recompress a drive by using a single compression method, or you can use different methods for individual files and
folders. You can also leave individual files and folders (or your entire drive) uncompressed.

Tips
. You can run System Agent to change the schedule and compression settings for Compression Agent.
. You can also run Compression Agent by clicking the Start button, pointing to Programs, pointing to Accessories, pointing
to System Tools, and then clicking Compression Agent.



Compressed drive information

To view compression information for a drive, in My Computer or Windows Explorer, click the drive icon, click the File menu, and
then click Properties. Then, click the Compression tab.

You can run DriveSpace 3 from the Compression tab to compress an uncompressed drive, upgrade a drive to DriveSpace 3, or
adjust the compression settings for a drive that is already compressed. When you view information for a DriveSpace 3
compressed drive, you can also run Compression Agent to recompress files on the drive.



New desktop enhancements

Microsoft Plus! offers new features for enhancing your desktop, making screen fonts easier to read, and having fun too!
o Desktop themes
Animated mouse pointers
Enhancements to window dragging
Font smoothing
New desktop icons

| Wallpaper stretching
A new game: 3D Pinball

Desktop themes

Microsoft Plus! includes a variety of desktop themes that can enhance the look of your entire desktop. A desktop theme includes
a background wallpaper, a screen saver, a color scheme, and a set of sounds, cursors, icons, and fonts.

You can use a theme as it is, or you can modify it by changing one or more of its desktop elements.

To select a desktop theme, double-click Desktop Themes in Control Panel.

Note
. Some desktop themes, such as Dangerous Creatures, require a video card and monitor that support at least 256 colors.
Other desktop themes, such as Mystery, require a video card and monitor that support high color (16-bit or greater).
To see which themes are high color, double-click the Desktop Themes icon in Control Panel, and then scroll through the
Theme list.



Animated mouse pointers

Microsoft Plus! provides the ability to use animated mouse pointers. The desktop themes include several animated mouse
pointers that you can use with the themes or independently.

To use an animated mouse pointer independently of a theme, double-click the Mouse icon in Control Panel.

Tips
Animated mouse pointers work best for pointers that don't require precision, such as the Working-In-Background and
Busy pointers.

If you can't find the mouse pointers you want, try looking in the Windows\Cursors folder, the Program Files\Plus\Themes
folder, or your Microsoft Plus! folder



Enhancements to window dragging

With Microsoft Plus!, you can see the contents of a window as you move it, instead of just a window border. You can also see
how much information fits in the window as you size it.

To use this feature, double-click the Display icon in Control Panel, click the Plus! tab, and then make sure the Show Window
Contents While Dragging box is checked.



Font smoothing

Font smoothing makes large fonts look better on your screen by smoothing out any jagged edges.

If you want to conserve memory, you can turn off font smoothing by double-clicking the Display icon in Control Panel and then
clicking the Plus! tab.

Note
To take advantage of font smoothing, you must have a monitor and video card that support at least 16-bit (high) color.



New desktop icons

The desktop themes include new icons to represent My Computer, Network Neighborhood, and the Recycle Bin on your desktop.
These icons also come in different sizes to suit your display.

To use the desktop icons you want, double-click the Display icon in Control Panel, and then click the Plus! tab.



Wallpaper stretching

With Microsoft Plus!, you can stretch the wallpaper on your desktop so that it fills the entire screen.

To stretch wallpaper, double-click the Display icon in Control Panel, and then click the Plus! tab. In the Wallpaper area of the
Background properties, make sure Center is selected.



A new game: 3D Pinball

Turn your desktop into a game table and enjoy a round of pinball! The 3D Pinball game resembles many of the pinball games
that you see in video arcades.

To play 3D Pinball, click the Start button, point to Programs, point to Accessories, point to Games, and then click Pinball.

For information about how to use 3D Pinball, click the Help menu in the game.



New network and Internet features

Microsoft Plus! offers new features for connecting to and browsing the Internet. It also provides a new feature for setting up your
computer so others can dial into it.
linternet Setup wizard
Internet mail support
Internet Explorer
Internet security
Automatic dial-up to the Internet

_| Server capabilities for Dial-Up Networkin
_| Scripting support for Dial-Up Networking

Internet Setup wizard

Microsoft Plus! provides a wizard that you can use to quickly and easily set up an Internet connection using The Microsoft
Network or another company as your Internet access provider.

If you want to use a service provider other than Microsoft, the wizard will configure Microsoft Exchange so that you can send and
receive mail to and from other people on the Internet.

If you did not run the Internet Setup wizard after setting up Microsoft Plus!, click the Start button, point to Programs, point to
Accessories, point to Internet Tools, and then click Internet Setup Wizard.



Internet mail support

By using Microsoft Plus! and Microsoft Exchange, you can now send and receive mail to and from other people on the Internet.

If you use The Microsoft Network, then you already have access to Internet mail. If you use an Internet access provider other
than The Microsoft Network, you can set up Microsoft Exchange for Internet mail by running the Internet Setup wizard.

To run the Internet Setup wizard after setting up Microsoft Plus!, click the Start button, point to Programs, point to Accessories,
point to Internet Tools, and then click Internet Setup Wizard.



Internet Explorer
Once you have set up an Internet connection, you can begin browsing the Internet by clicking the Internet icon on your desktop.

Browsing the Internet is easy with Internet Explorer; just click the topics that interest you. You can browse sites anywhere on the
Internet, include information you find in your documents, and even save the information in a file on your computer.

Internet Explorer keeps track of the topics you've viewed, so you can quickly return to any topic you want. And, you can maintain
a collection of your favorite topics.



Internet security

Connecting to the Internet through a local area network (LAN) can be a security risk, since others on the Internet can gain
access to information on your network via your computer. To ensure network security, Microsoft Plus! provides support for proxy
servers to protect information on your network from being accessed by others on the Internet.

Depending on the capabilities of the proxy server, you can also use it to temporarily store pages that you've viewed in Internet
Explorer, which makes browsing among viewed pages faster.

To specify a proxy server, click the Internet icon in Control Panel, and then click the Advanced tab. For more information about
using a proxy server, contact your network administrator.



Automatic dial-up to the Internet

Microsoft Plus! provides automatic dialing capabilities that connect you to the Internet only when you try to access it.

You can also use this feature to automatically disconnect from the Internet if you have not actively used it for a while. This frees
up your phone line and minimizes connection time, which can save you money on connection-time fees.

To set up automatic dialing, click the Internet icon in Control Panel.



Server capabilities for Dial-Up Networking

Microsoft Plus! provides an addition to Windows 95 Dial-Up Networking that enables you to dial in to your computer from a
remote location, and then use the network resources available on it. Dial-Up Networking provides password protection so that
other people who know the password can also dial into your computer.

To set up your computer to dial into it, you must have a modem, and you must specify dial-up options for it. To set up a modem,
double-click the Modems icon in Control Panel.

To set up dial-up options, double-click the Dial-Up Networking folder in My Computer, and then click Dial-Up Server on the
Connections menu.



Scripting support for Dial-Up Networking

Many Internet access providers, online services, and remote computers require you to enter information, such as your user
name and password, to establish your connection. With Microsoft Plus!, you can create a Dial-Up Networking script that provides
this information automatically, so that you do not have to type it in each time you connect.

To use a Dial-Up Networking script, create a script file in a text editor, such as Notepad, and then use the Dial-Up Scripting Tool
to assign the script to your Dial-Up Networking connection.

For more information about how to create and assign scripts, look up "scripting" in the Windows Help Index.



A compressed drive is not an actual disk drive, although it appears as one in Windows 95. Instead, the contents of a compressed
drive is stored in a compressed volume file (CVF). Compressed volume files are hidden and have names such as Drvspace.000.

Microsoft Plus! uses DriveSpace 3, a new CVF format for compressed volume files, which provides maximum compression.



With standard compression in Windows 95, files are typically compressed to just over half their original size. With standard
compression in Microsoft Plus!, more of your disk is searched for repetitive data, providing even better compression, while
maintaining performance when reading and writing information on the drive.



HiPack compression provides more compression than standard compression while maintaining excellent performance when
reading information on a compressed drive. However, writing information may take longer.

HiPack typically compresses files to just under half their original size. For example, if you use HiPack to compress a 10 MB file, it
may take up only 5 MB, saving 5 MB of disk space.



UltraPack compression provides maximum compression for the most disk-space savings.

UltraPack compression typically compresses files to as small as one-third their original size. For example, if you use UltraPack to
recompress a file that was originally 10 MB uncompressed, it may take up only 3 MB. However, accessing UltraPacked files may
be slower if you are using a 486-based computer.



The World Wide Web is a collection of documents stored on computers connected to the Internet. World Wide Web documents
contain hypermedia links to other documents on the World Wide Web.

By using an Internet browser, such as Internet Explorer, you can open and read these documents, and even save them on your
own computer.



Microsoft Plus! supports three compression methods (standard, HiPack, and UltraPack) that determine how much your files are
compressed.

Microsoft Plus! standard compression provides better compression than DoubleSpace or DriveSpace standard compression.
HiPack provides even better compression than standard, and UltraPack provides the most compression for maximum disk-space
savings. However, the more disk compression you use, the slower your system may be when reading and writing files to a
compressed drive.



A proxy server acts as a barrier between the Internet and your local area network (LAN), protecting information on your LAN from
being accessed by others.

When you use a proxy server, all requests to and from the Internet are filtered through it, so confidential information on your
network does not become available on the Internet. Proxy servers can provide other Internet services as well.

For more information about your proxy server, see you network administrator.



A script file contains scripting commands that provide and retrieve information to and from the remote computer you are
connecting to. This information includes your user name and password, port information, carriage returns, line feeds, and
pauses.



Prevents you or other people from dialing in to this computer.



Enables you or other people to dial in to this computer.



Click this to assign a password to this modem. The password prevents unauthorized users from using Dial-up Networking to gain
access to this computer and any network resources connected to it.

If you enable password protection but leave the password blank, anyone trying to connect must leave the box blank to
successfully connect.



Disconnects anyone who is connected to this computer through Dial-Up Networking.



Provides a space for you to type descriptive information about this connection, such as the phone number required to dial into
your computer.



Displays the connection status of your computer. For example, this field tells you if your computer is checking for incoming calls,
or if someone is dialing into or is connected to your computer.



Click this to specify the dial-up server type for your computer and to set compression and password options that take effect when
dialing into your computer.



Lists the desktop themes available in Microsoft Plus!

You can select a theme and use it as is, or you can modify it and create a new theme by changing individual sound, mouse, and
desktop settings.

If you are using a 486-based computer, you might want to change your color-palette setting to 256-color, and then use a 256-

color theme for best performance. To change your color-palette setting, double-click the Display icon in Control Panel, and then
click the Settings tab.



Click this to save your current window settings as a theme.

You can either create a new theme or replace an existing theme with your current window settings. To create a new theme, you
need to provide a unique name for it.



Click this to delete the selected theme from the Themes list. Deleting a theme does not delete the associated media files from
your disk, it only deletes the theme file (files with a Windows .theme or MS-DOS .the extension).

If you decide to use the theme later on, you can restore it. To restore it, double-click the Add/Remove Programs icon in Control
Panel, and then click Install. Follow the instructions on your screen.



Click this to see a preview of the screen saver for the selected theme. To dismiss the screen saver after viewing it, move your
mouse or press a key.

You can change the screen saver by double-clicking the Display icon in Control Panel.



Click this to see previews of the mouse pointers, sounds, icons, and wallpaper for the selected theme.



Shows how your desktop will look when the selected theme is applied.



Replaces the current screen saver with the screen saver for the selected theme. If you want to keep the current screen saver,
leave this box unchecked.

You can select a different screen saver by double-clicking the Display icon in Control Panel and then clicking the Screen Saver
tab. The most recent screen saver you select is the one that takes effect.



Replaces the current sounds with the sounds for the selected theme. If you want to keep the current sounds, leave this box
unchecked.

You can select different sounds by double-clicking the Sounds icon in Control Panel. The most recent sounds you select are the
ones that take effect.



Replaces the current mouse pointers with those for the selected theme. If you want to keep the current mouse pointers, leave
this box unchecked.

You can select different pointers by double-clicking the Mouse icon in Control Panel and then clicking the Pointers tab. The most
recent mouse pointers you select are the ones that take effect.



Replaces the current wallpaper with the wallpaper for the selected theme. If you want to keep the current wallpaper, leave this

box unchecked.
You can select a different wallpaper by double-clicking the Display icon in Control Panel. The most recent wallpaper you select is

the one that takes effect.



Replaces the current icons for My Computer, Network Neighborhood, and Recycle Bin with icons for the selected theme. If you
want to keep the current icons, leave this box unchecked.

You can select different icons by double-clicking the Display icon in Control Panel and then clicking the Plus! tab. The most
recent icons you select are the ones that take effect.



Replaces the current system colors with the colors for the selected theme. If you want to keep the current colors, leave this
option unchecked.

You can select different colors by double-clicking the Display icon in Control Panel and then clicking the Appearance tab. The
most recent colors you select are the ones that take effect.



Replaces the current screen fonts with the fonts for the selected theme. If you want to keep the current fonts, leave this option
unchecked.

You can select different fonts by double-clicking the Display icon in Control Panel and then clicking the Appearance tab. The
most recent fonts you select are the ones that take effect.



Replaces the current window and font sizes with the sizes for the selected theme. If you want to keep the current sizes, leave
this option unchecked.

You can also select different sizes by double-clicking the Display icon in Control Panel and then clicking the Appearance tab. The
most recent window and font sizes you select are the ones that take effect.



Displays the My Computer, Network Neighborhood, and Recycle Bin icons using the icon size and spacing for the selected
theme.

Some themes include large icons, which can take up more memory. If you are currently using small icons on your desktop and
your theme includes large icons, you can conserve memory by leaving this option unchecked.



Lists the names of the mouse pointers that go with the selected theme.



Displays the selected mouse pointer.



Shows the location and filename for the selected mouse pointer.



Lists the names of the sounds that go with the selected theme.



Shows the icon for the selected sound.



Shows the location and filename for the selected sound.



Plays the selected sound.



Lists the names of the wallpaper, screen saver, and icons for My Computer, Network Neighborhood, and the Recycle Bin that
match the selected theme.



Displays the selected wallpaper or icons.



Shows the location and filename for the selected wallpaper, screen saver, or icon.



Click this to start recompressing files on your drive.



Shows the changes in disk space for different compression methods.

For example, if files that were previously compressed using UltraPack are recompressed using HiPack, the value for Space Lost
To Improve Performance will increase for HiPack, because HiPacked files take up more disk space than UltraPacked files.

Similarly, if files that were previously compressed using HiPack are recompressed using UltraPack, the value for Space Gained
To Increase Compression will increase for UltraPack, because UltraPacked files take up less disk space than HiPacked files.



Shows what percentage of your disk has been recompressed. You can use your computer while Compression Agent is running.
However, recompression will take longer and your computer will perform slower.



Click this to stop Compression Agent so that you can select a different drive or quit the program.



Click this to pause Compression Agent. Pausing Compression Agent is useful if you need to use your computer for a while and
don't want it to perform slowly.

To continue recompressing files on your drive, click Resume.



Click this to specify the compression method to use when recompressing files on the drive.



Displays a Help topic that describes how Compression Agent keeps track of disk space and performance as it recompresses
files on the drive.



Lists the drives that you can recompress files on.

Compression Agent can recompress files on drives that were compressed or upgraded by using DriveSpace 3. Compression
Agent cannot recompress files on CD-ROM drives, network drives, or drives that are not compressed in DriveSpace 3 format.



Click this to resume recompressing files on the same drive.



Click this to select a different disk drive to recompress files on.



Click this to quit Compression Agent.

To safeguard your information, Compression Agent finishes recompressing the file it is currently working on before quitting. It
might take a few seconds before Compression Agent clears your screen.



Does not use UltraPack compression on any files.



Uses UltraPack compression on all files to achieve maximum disk space. Because it takes longer to open files compressed with
UltraPack, this option may slow down your system, unless you are using a Pentium or faster computer.

Depending on the type of processor and amount of memory you have, it may also take longer to compress files using UltraPack
than by using another compression method.

Note On some files, using UltraPack does not regain disk space. In this case, Compression Agent uses HiPack on those files to
maintain performance, even if you choose to UltraPack all files on the drive.



Uses UltraPack compression to recompress only those files opened within the number of days you specify. You can type a
number in the box, or click the arrows to set the number of days.

Because it takes longer to open files compressed with UltraPack, use this option to achieve maximum compression on files that
you use infrequently.



Uses HiPack compression on all files, except for those that are compressed in UltraPack. This method achieves a very high level
of compression without losing performance when opening files.



Stores all files uncompressed, except those that are compressed in UltraPack.

This option is useful if you have a 486-based computer and want to increase the speed at which files are accessed. But because
your files are uncompressed, they will take up considerably more disk space.



Click this for additional options for maximizing free space on the drive.



Saves your changes as the new default settings.

If this box is not checked, the settings you changed are used this time only to recompress files.



Click this to specify the type of compression to use for individual files and folders on your computer. The exceptions you set will
override the settings in this dialog box.



If free space drops below the specified amount, this option maintains the current compression level of all files on the drive. Type
a number or click the arrows to change the amount of free space.

This setting overrides all other settings in Compression Agent, including any exceptions you've set for individual files or folders.
For example, if you specify no compression for a file that was previously compressed using HiPack, and you are low on disk
space, the file will remain in HiPack format.



If checked, files currently UltraPacked remain in UltraPack format, even if you've accessed them recently or have changed their
compression settings.

If this option is unchecked, then UltraPacked files may be recompressed using HiPack, or they may be uncompressed,
depending on the option you chose for your other files in the Settings dialog box, and on how much free disk space you have.

Note The settings you specify in the Exceptions dialog box override this option. For example, if you uncompress a file that is
currently UltraPacked, Compression Agent uncompresses the file when it recompresses this drive, even if this option is checked.



Lists individual files, folders, and file types, and the compression option you specified. Files and folders that are not in this list are
recompressed as specified in the Settings dialog box.



Click this to add another file, folder, or file type to the list.



Click here to change the compression method used when recompressing the selected item in the list.



Click this to remove the selected file, folder, or file type from the list. This file or folder will be compressed as specified in the
Settings dialog box.



Sets a compression method for a file. If you know the name and location of the file, you can type its path in the box; otherwise,
you can click Browse to find it.



Sets a compression method for a folder.

If you know the name and location of the folder, you can type its path in the box. If you have two folders with the same name on
different drives, you can set the same compression method for both folders by typing \foldername. If you don't know the name
and the location of the folder, you can click Browse to find it.

The option you specify applies to the entire folder, including any subfolders and the files it contains.



Sets a compression option for a particular file type. For example, you can specify all the bitmap files by typing *.bmp in the box
above.



Provides a space for you to type the locations and names of the individual files and folders for which you want to set
compression methods.

If you select All Files Of Specified Type, then you must provide the filename extension. For example, to use a specific
compression method to compress all your bitmap files, you could type either bmp or *.bmp in the box.



Click this to find the file or folder you want to specify a compression method for.



Specifies that the selected file, folder, or file type should always be recompressed using UltraPack compression.

Because it takes longer to open UltraPacked files, use this method to achieve maximum compression on files you use less
frequently.



Specifies that the selected file, folder, or file type should always be recompressed using HiPack compression.



Specifies that the selected file, folder, or file type should always be stored in an uncompressed format.



Click this to save the compression exception you set. This compression exception gets added to the list in the Exceptions dialog
box.

This dialog box stays open so that you can set compression exceptions for additional files and folders.



Click this to close this dialog box and return to the Exceptions dialog box.



Compression Agent overview

With Compression Agent, you can save disk space by compressing files even more, or improve performance by changing the
level of compression on your files. While files on your drive are being recompressed, Compression Agent updates the
information in the table to reflect how your disk space changes as files are moved from one compression method to another.

For example, if a file that was previously HiPacked is recompressed using UltraPack, the column Space Gained By Increasing
Compression shows a higher value for UltraPack because these files take up less disk space.

Similarly, if a file that was previously UltraPacked is recompressed using HiPack, the column Space Lost To Improve
Performance shows a higher value for HiPack because these files take up more disk space.

Tips
o You can balance disk space and performance by changing the way Compression Agent compresses your files. To do this,
click Settings.
Compression Agent is scheduled to run at regular intervals. You can change the schedule by using System Agent.



To schedule a program to run at a specific time

Click here ﬂ to open System Agent.

On the Program menu, click Schedule A New Program.

Select the program from the Program list. If the program isn't listed, type the name of the program in the box, or click Browse.
If the program uses files in another folder, type the name of the folder in the Start In box.

If you want a description of the program to appear in the System Agent window, type it in the Description box.

In the Run list, click the way you want the program to run.
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To set up the schedule for the program, click When To Run.

Tips
Programs such as Disk Defragmenter, ScanDisk, and Compression Agent that are configured for scheduling, enable you

to change their settings. If you are scheduling this type of program, click Settings to customize how the program runs at its
scheduled time.

Make sure that the system date and time for your computer are accurate. System Agent uses this information to run
scheduled programs. You can use the Date/Time icon in Control Panel to update your computer's date and time.

For information about how to use System Agent, click the Help menu in System Agent.

{button ,AL(WINDOWS_DATE_CHANGE_DATE;WINDOWS_DATE_CHANGE_TIME;a_sched_program')} Related Topics



To display a low-disk-space notification

1 Click here ll to open System Agent.
2 Click Low Disk Space Notification.
3 On the Program menu click Properties, and then click Settings.
4 Click the drive you want to set a notification for, and then make sure the Notification box is checked.
You can also change when you receive the notification. When the space left on the drive drops below this number, the
reminder is displayed.
Tip
o If the low-disk-space notification is not scheduled, you can reschedule it by clicking Schedule A New Program on the
Program menu and then clicking Low Disk Space Notification in the Program list.

{button ,AL("a_sched_program")} Related Topics



To schedule Backup to back up your files

1 Click here ll to start Backup.

2 Click the files you want to back up.
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Click Drag and Drop on the Settings menu, and then make sure the Confirm Operation Before Beginning box is unchecked
and the Quit Backup After Operation Is Finished is checked, and then click OK.

Click Options on the Settings menu, and then click the Backup tab.

Click the type of backup you want and make other changes as needed. Then click OK.
Click Next Step.

Select a destination, and then on the File menu, click Save As.

Type a name for the file set, and then click Save.

Quit Backup.

10 Click here ll to open System Agent.
11 On the Program menu, click Schedule a New Program.
12 In the Program box, type the following, including the quotation marks:

"C:\Program Files\Accessories\Backup.exe" C:\Program Files\Accessories\setname.set
where setname.set is the name you assigned to the file set.

13 Click When to Run to schedule Backup.

Tip

You can schedule both full and incremental backups. For example, you could schedule a full backup to run once or twice a

month and an incremental backup to run daily.

If you do this, make sure your daily backup does not interfere with your full backup on the days that the full backup is
scheduled.



To upgrade a compressed hard drive to DriveSpace 3

1 Click here ll to start DriveSpace 3.

2 Click the drive you want to upgrade.
3 On the Drive menu, click Upgrade, and then click Start.
4 To back up your files before upgrading the drive, click Back Up Files, and then follow the instructions on your screen.
5 Click Upgrade Now.
6 If Windows prompts you to restart your computer, click Yes.

Tips

If your drive is not yet compressed, click Compress on the Drive menu to create a DriveSpace 3 compressed drive.

o For information about how to use DriveSpace 3, click the Help menu in DriveSpace 3.

{button ,AL("a_upgrade_advantages")} Related Topics



To change the compression method

1 Click here ll to start DriveSpace 3.
2 On the Advanced menu, click Settings.

3 In the Compression Method area, click the method you want.

Tips

Try using No Compression, Unless Drive is 90% Full; Then Use Standard Compression. Windows will save your files
uncompressed if you have plenty of disk space. But if your disk gets full, Windows saves your files using standard compression.

If you use the No Compression option, the free space that Windows reports on your drive will drop significantly. To regain
the extra free space, schedule Compression Agent to compress your files while you are not using your computer. Run System Agent
to schedule Compression Agent.

You can change the point at which Windows starts compressing your files by changing the disk-space percentage.

o For information about how to use DriveSpace 3, click the Help menu in DriveSpace 3.

{button ,AL("a_sched_program")} Related Topics



To set up your computer as a Dial-Up Networking server

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.
2 On the Connections menu, click Dial-Up Server.

3 Click Allow Caller Access.
4

If you want to assign a password so that only those who know the password can dial into your computer, click Change
Password.
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Click Server Type.
6 Click a server from the Type of Dial-Up Server list, and then click OK.

Tips
o Before setting up your computer as a Dial-Up Networking server, you must set up a modem.
o For Help on an item, click

Llatthe top of the dialog box, and then click the item.

{button ,AL("a_dial_link;a_modem_set_up")} Related Topics



To choose a theme for your desktop

1 Click here ﬂ to open the Desktop Themes window.
2 In the Theme list, click the theme you want to use.

3 If you don't want to use one of the theme's desktop items, make sure it is unchecked.

Tips
You can customize an existing theme by changing different desktop elements. You can also create a new theme by saving
your changes to an existing theme under a new name.

If you are using a 486-based computer, make sure your color palette is set to 256-color, and then use a 256-color theme
for best performance.

To change your color-palette setting, double-click the Display icon in Control Panel and then click the Settings tab.

For Help on an item, use the right mouse button to click an item, and then click the What's This? command.

{button ,AL("a_createcust_theme")} Related Topics



To customize a desktop theme

1 If you are not using a Desktop Theme, click the Desktop Themes icon in Control Panel, click the theme you want to customize,
and then click OK.

2 Use the Sound, Mouse, and Display icons in Control Panel to select your favorite sounds, pointers, or desktop items.

3 In Control Panel, click the Desktop Themes icon again and make sure that Current Windows Settings is displayed in the
Theme list.

4 Click Save As, and then type the name for the customized theme.

To create a new theme with these settings, type a unique theme name.

Tips
| You can share your custom themes with other people.
o You can use bitmap images (files with a .bmp filename extension) as desktop icons or as wallpaper for a theme.

{button ,AL("a_theme_share")} Related Topics



To create your own desktop theme

1 Use the Sound, Mouse, and Display icons in Control Panel to select your favorite sounds, pointers, or desktop items.
2 In Control Panel, click Desktop Themes, and then make sure that Current Windows Settings is selected in the Theme list.

3 Click Save As, type a unique theme name, and then click OK.

Tips
| You can share the themes you customize or create with other people.
o You can use any files with a .bmp filename extension as desktop icons or as wallpaper for a theme.

{button ,AL("a_theme_share")} Related Topics



Using desktop themes created by other people

Each desktop theme has a theme file that contains information about the theme's media files. You share a desktop theme by
sharing the folder that contains the theme file and its media files.

If you want to use a theme that someone else created and shared, store the theme and media files in the Theme folder within the
folder that contains your Microsoft Plus! program files (the default folder is Program Files\Plus'\Themes). Store the theme's fonts
in the Fonts folder, and store the screen saver in the Windows folder.

{button ,AL("a-sharefolder")} Related Topics



A theme file includes the location and filenames of the media files that are part of a desktop theme. Theme files have a .the
filename extension and are identified as desktop theme files in the list view of the Theme folder.



A media file is the file for a sound, wallpaper, pointer, screen saver, or other desktop item. Media files are identified as wave
sounds, cursors, icons, bitmap images or animated cursors in the list view of the Theme folder.

The location and filenames for the theme's media files are stored in the desktop theme (.the) file.



To change icon settings

1 In Control Panel, double-click the Display icon, and then click the Plus! tab.
2 Click the icon you want to change, and then click Change Icon.
3 Click the icon file you want to use, and then click OK.
Tip
o If you want to speed up system performance, make sure this option is unchecked.



To view the contents of a window as you move or size it

1 In Control Panel, double-click the Display icon, and then click the Plus! tab.

2 Make sure Show Window Contents While Dragging is checked.

Tips
o This option is handy when you are sizing windows, because you can see how much information will fit into the window as
you drag its borders.
Uncheck this option if you don't want the window you are moving to cover up other windows on your screen.
o If this option is checked and you are using a 486-based computer, you may see "trails" as you move a window.



To smooth the edges of large screen fonts

1 In Control Panel, double-click the Display icon, and then click the Plus! tab.
2 Make sure Smooth Edges Of Screen Fonts is checked.

Note
To use font smoothing, you must have a monitor and video card that support at least 16-bit (high) color.



To stretch wallpaper to fit your screen

1 In Control Panel, double-click the Display icon, and then click the Plus! tab.

2 Make sure Stretch Desktop Wallpaper To Fit Screen is checked.

3 Click Background, and then in the Wallpaper area, make sure Center is selected.

Tip
o If you want to improve system performance on a 486-based computer, make sure Stretch Desktop Wallpaper to Fit
Screen is unchecked.



To increase free space on a compressed disk

1 Make sure you have upgraded your compressed drives to DriveSpace 3.
2 Click here ll to open System Agent.

3 Click Compression Agent.
If Compression Agent is not scheduled, click Schedule A New Program on the Program menu to schedule it.
4 If you want to change the compression settings, click Properties on the Program menu, and then click Settings.

If you want to change the time at which Compression Agent runs, click Change Schedule on the Program menu.
5 If you won't be using your computer for a while and want to increase free space on your drive now, click Run Now on the
Program menu.
Tip
You can also run Compression Agent at any time by clicking the Start button, pointing to Accessories, pointing to System
Tools, and then clicking Compression Agent.

{button ,AL("a_upgrade_drive")} Related Topics



Microsoft Plus! offers DriveSpace 3 compression, which enables you to create and maintain larger compressed drives. When you
compress your drive for the first time, Microsoft Plus! automatically creates a DriveSpace 3 drive. If you compressed your drive
using DoubleSpace or DriveSpace for MS-DOS or DriveSpace for Windows 95, you can upgrade your drive to DriveSpace 3.



This program is not installed on your computer. To install it:

1 Have your Windows 95 and Microsoft Plus! installation floppy disks or CD-ROM disk handy.
2 Click here ll to open the Add/Remove Programs properties.

3 Click Microsoft Plus! for Windows 95, and then click Add/Remove to start Setup.

4 Click Add/Remove, and then follow the instructions on your screen.



More ways to free disk space with Microsoft Plus!
To free up more space on your hard disk by using Microsoft Plus!, you can:
" Upgrade your compressed disk to DriveSpace 3
. Adjust the compression settings in DriveSpace
. Reallocate free space on a compressed or host drive
" Recompress files on your compressed drives
You can also fine-tune compression to maintain maximum disk space, maximum speed, or a balance between the two. For step-

by-step instructions on how to do this, click Fine-Tune Compression.

" Fine-tune compression




Upgrade your compressed disk to DriveSpace 3

Click here ll to start DriveSpace 3.
Click the drive you want to upgrade.
On the Drive menu, click Upgrade.
Click Start.
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Windows may prompt you to update your startup disk. To update your startup disk, click Yes, insert your startup disk in floppy
drive A, and then click Create Disk.

[«2)

If you have not backed up your files, click Back Up Files, and then follow the instructions on your screen.
7 Click Upgrade Now.

8 If Windows prompts you to restart your computer, click Yes.

Note

. You can only upgrade hard disks that have been compressed using DoubleSpace or DriveSpace for MS-DOS, or
DriveSpace for Windows 95.

Do you want to free up more disk space?
" Yes.
" No. | want to see how much free disk space | have now.



Adjust the compression settings in DriveSpace

1 Click here ll to start DriveSpace 3.
2 On the Advanced menu, click Settings.
3 If you are using a 486-based computer, click Standard, or click No Compression, Unless Drive Is At Least 90% Full; Then Use
Standard Compression, and then change the percentage as needed.

If you are using a faster computer, such as a Pentium, click HiPack.

Notes
. Compressing files as you save them does not free disk space immediately. It helps to maintain the free disk space you

currently have.
" If you are already compressing your files as you save them, Click Yes for more ways to free disk space.

Do you want to free up more disk space?
" Yes.
" No. | want to see how much free disk space | have now.



Reallocate free space on a compressed or host drive
1 Click here ll to start DriveSpace 3.
2 Click the compressed or host drive that is low on free space.
3 On the Drive menu, click Adjust Free Space.
4 Move the slider to gain more space on the drive, or increase the free space by typing a number in the Free Space box.
Do you want to free up more disk space?

- Yes.
. No. | want to see how much free disk space | have now.



Recompress files on your compressed drives

1 Make sure you have upgraded your compressed drives to DriveSpace 3.

2 Click here ﬂ to start Compression Agent.
3 If you have more than one compressed drive, click the drive you want to recompress.
4 Click Settings, and then if you are using a Pentium or faster computer, click UltraPack All Files.
If you are using a 486-based computer, click UltraPack Only Files Not Used Within The Last 30 Days to UltraPack only
those files that you use infrequently, and then change the number of days if needed. Then click Yes to HiPack the rest of your files.

5 If you want to use tighter compression on specific files, click Exceptions and then change the settings as needed. When you
are finished, click OK.

6 Click OK again, and then click Start.

Tip
. Once you upgrade or compress a drive using DriveSpace 3, System Agent schedules Compression Agent to run at
regular intervals. You can use System Agent to configure the compression settings that Compression Agent uses so that you can
maintain the maximum amount of free space on your disk.

Do you want to free up more disk space?
. Yes.
" No. | want to upgrade my drive to DriveSpace 3 now.
- No. | want to see how much free disk space | have now.



Shows how the screen saver will appear on your desktop using settings you've specified. The speed at which the screen saver
will move when activated will vary slightly from the speed at which it moves here.



Uses a lens that simulates a transparent sphere that rolls across your desktop.



Uses a lens that simulates a view from above your desktop. The items on your desktop appear through the lens as if they were
turned inside out.



Uses a lens that pulls items on your desktop toward the center of the lens.



Uses a lens that bumps into items on your desktop, creating a "dent" in the items. As the lens passes over items, they are either
pushed in or stretched out, depending on the value you set in the Height box.



Uses a lens that swirls a portion of your desktop into a spiral.



Specifies the diameter of the lens in pixels. You can type a number or click the arrows to set the size.

If you want a larger lens, increase the number.



Specifies how quickly the lens moves across your desktop. You can type a number or click the arrows to set the speed.

If you want the lens to move faster, increase the number.



Specifies the degree to which light is refracted as it passes through the sphere. You can type a number to set the refraction
index.

To allow light to travel straight through the sphere and thereby make the lens invisible, set this option to 1. To simulate a glass
sphere, try a value of 1.4. To simulate an air bubble in water, try a value of 0.75.



Specifies how far away the inside-out lens is from your desktop. You can type a number to set the distance.



Specifies the mass for the black hole lens. You can type a number or click the arrows to set the mass.

The higher the mass, the more the lens pull items toward its center. Values between 0.00 and 1.0 will achieve the effect of the
black hole lens; however, you can achieve other interesting effects by using numbers greater than 1 and less than 0.



Specifies how much the lens pushes in or stretches out items. A positive value causes the lens to stretch items out, and a
negative value causes the lens to push items in. You can type a number or click the arrows to set the height.

Values between -1.0 and 1.0 will achieve the denting effect; however, you can achieve other interesting effects by using numbers
greater than 1.0 and less than -1.0.



Specifies the number of times the spiral lens twists around. You can type a number or click the arrows to set the number of
twists.

A positive value causes the lens to twist counter-clockwise. A negative value causes the lens to twist clockwise.



Flips the background of your desktop horizontally or vertically every five minutes.



Moves the lens over just the background wallpaper instead of over the entire desktop.



Specifies which corner of your screen will activate the screen-saver option you select.

Click a corner, and then click the option you want. After setting options, you can move the mouse pointer to an active corner, and
the screen saver will either appear immediately or won't appear at all, depending on the option you selected.



Prevents sounds associated with the screen saver from being played when the screen saver is active. If you want to hear
sounds, make sure this box is unchecked.



Determines how much you need to move the mouse to clear the screen saver.

To keep the screen saver on in case you accidentally bump the desk your computer is on, click Low or Normal. Click Keyboard
Only to clear the screen saver by pressing a key on the keyboard.



Specifies how long the screen saver should run before a password is required to clear it. Type a number or click the arrows to
set the amount of time, and then select a unit of time from the list.

If you clear the screen saver before the specified amount of time has passed, you do not need to enter the password. After the
specified amount of time passes, you must type your password to clear the screen saver.



Click this to view copyright information about this screen-saver program.



For a quick and easy way to set up an Internet connection

1 Click here * to start the Internet setup wizard.

2 Follow the instructions on your screen.

Notes
. If you want to use an Internet access provider other than The Microsoft Network, you might need to supply Internet
account and address information to establish your connection. You can obtain this information from your Internet access provider.
" If you want to connect to the Internet through a local area network (LAN), make sure there is an Internet gateway
computer on your network. Also, you might want to set up a proxy server to protect information on your network. For more
information, contact your network administrator.




To browse the Internet

1 Click here ® to start Internet Explorer.
2 Click the topic you want to view.

If you know the address for a particular Web site or page, click File and then click Open. Type the address in the box.

Tips
. You can also start Internet Explorer by clicking The Internet icon on your desktop.
" You can save connection time and money when browsing the Internet by using the Internet icon in Control Panel to set
Autodialing options.
. For information about how to use Internet Explorer, click the Help menu in the Internet Explorer window.

{button ,AL('a_auto_dial')} Related Topics



To save connection time while using the Internet

1 In Control Panel, click the Internet icon.
2 Make sure the Use AutoDial option is checked.
3 Inthe list in the Settings area, click the Dial-Up Networking connection you want to use to establish your Internet connection.
4 Make sure Auto Disconnect is checked.
5 Change additional settings as needed.
Tip
. The Auto Disconnect option disconnects you from the Internet if you have not actively browsed it for the number of

minutes you specify. When you begin using the Internet again, the Use AutoDial option will reestablish your connection. This frees
up your phone line and saves you money.



To protect your shared resources from Internet access

1 In Control Panel, click the Internet icon.

2 To protect your shared files and printers from being accessed by others on the Internet, make sure the Perform System
Security Check Before Dialing option is checked.



To protect your network from Internet access

1 In Control Panel, click the Internet icon, and then click the Advanced tab.

2 Make sure Use Proxy Server is checked and then provide the address and port number of the proxy server on your network. If
you do not know the address or port number, contact your network administrator.

Tip
. To bypass a proxy server when accessing another computer, domain, or port on the Internet, type the names of the
computers, domain, or ports, separated by commas, in the Bypass Proxy On box.
Whenever you access one of these items, your request goes directly to the computers you specify, and bypasses the
proxy server.



An Internet gateway computer acts as a bridge between your network and the Internet. On a local area network, you can get
access to the Internet by connecting to this computer.



Fine-tuning compression

With Microsoft Plus!, you can fine-tune compression to achieve maximum disk space, maximum speed, or the best balance
between the two.

Click a button to begin fine tuning compression, or click the Overview button for a brief description of compression in Microsoft

Plus!
. Fine-tune for maximum speed
" Fine-tune for maximum disk space
" Fine-tune for a balance of speed and space

. Overview of Microsoft Plus! compression




Overview of Microsoft Plus! compression

The Microsoft Plus! enhancements to DriveSpace allow you to specify the type of compression in which to save files to a
compressed drive. This is handy for balancing speed and disk space while you are using your computer.

Microsoft Plus! also includes Compression Agent, a new file-compression program that helps you get the most out of your hard
disk space. Once you compress or upgrade a drive by using DriveSpace 3, System Agent automatically schedules Compression
Agent to run at regular intervals.

Depending on the settings you specify, Compression Agent will compact files for maximum disk space, or decrease file
compression for improved performance. You can use the Properties command in System Agent to change how Compression
Agent compresses your files.



To configure DriveSpace to save files uncompressed

1 Click here *® to start DriveSpace 3.
2 On the Advanced menu, click Settings.

3 Click No Compression, and then click OK.

Tip

To achieve maximum performance when saving files and compress disk space only if you are running low on free space,

click the option, No Compression, Unless The Drive Is At Least 90 Percent Full; Then Use Standard Compression. You can change
the disk-space percentage as needed.

What's next?
" Configure Compression Agent for maximum speed.



To configure Compression Agent for maximum speed

1 Click here® to start System Agent.

2 Click Compression Agent.
If Compression Agent is not scheduled, click Schedule a New Program on the Program menu to schedule it.

3 On the Program menu, click Properties, and then click Settings.
If you have more than one DriveSpace 3 drive, click the drive you want to change compression settings for, and then click
Settings.

4 Click Do Not UltraPack Any Files, and then click Yes to use HiPack compression on your files.

Tips

For maximum speed, click No, Store Them Uncompressed to uncompress all your files. However, this option will take up
considerably more disk space.

. You can also specify the compression method to use on an individual file or folder. To do this, click Exceptions.

. If you want Compression Agent to run at a different time, you can change its schedule by clicking Compression Agent in
the System Agent window and then clicking Change Schedule on the Program menu.

What's next?
- I'm finished fine-tuning compression. Go back to the beginning.



To configure DriveSpace to compress files as you save them

1 Click here *® to start DriveSpace 3.

2 On the Advanced menu, click Settings.

3 Click Standard Compression, and then click OK.

Tip
. Standard compression provides good compression without much loss in speed. However, if you are low on disk space
and have a Pentium or faster computer, try using HiPack.

What's next?
. Configure Compression Agent for maximum disk space.



To configure Compression Agent for maximum disk space

1 Click here® to start System Agent.
2 Click Compression Agent.

If Compression Agent is not scheduled, click Schedule a New Program on the Program menu to schedule it.
3 On the Program menu, click Properties, and then click Settings.

If you have more than one DriveSpace 3 drive, click the drive you want to change compression settings for, and then click
Settings.

4 For maximum disk space, click UltraPack All Files.

Tips
. Accessing UltraPacked files takes longer, especially on slower computers.
If you are using a 486-based computer, click UltraPack Only Files Not Used Within The Last 30 Days to UltraPack only
your infrequently used files, and then change the number of days if needed. Then click Yes to HiPack the rest of your files.
You can also specify the compression method to use on an individual file or folder. To do this, click Exceptions.
If you want Compression Agent to run at a different time, you can change its schedule by clicking Compression Agent in
the System Agent window and then clicking Change Schedule on the Program menu.

What's next?
. I'm finished fine-tuning compression. Go back to the beginning.



To configure DriveSpace to compress files only when disk space is low

1 Click here * to start DriveSpace 3.

2 On the Advanced menu, click Settings.
3 Click No Compression, Unless The Drive Is At Least 90 Percent Full; Then Use Standard Compression, and then click
OK.

This ensures that you will achieve maximum performance when saving files and will compress files only if you are running low
on free space.
Tip
. You can change when DriveSpace 3 starts compressing files by changing the percentage of full disk space.

What's next?
" Configure Compression Agent to balance speed and space.




To configure Compression Agent to balance speed and space

1 Click here® to start System Agent.
2 Click Compression Agent.

If Compression Agent is not scheduled, click Schedule a New Program on the Program menu to schedule it.
3 On the Program menu, click Properties, and then click Settings.

If you have more than one DriveSpace 3 drive, click the drive you want to change compression settings for, and then click
Settings.
4 For maximum disk space, click UltraPack Only Files Not Used Within The Last 30 Days to UltraPack files that you use
infrequently. Change the number of days if needed.
6 Click Yes to HiPack for the rest of your files.
Tips
" You can also specify the compression method to use on an individual file or folder. To do this, click Exceptions.

. If you want Compression Agent to run at a different time, you can change its schedule by clicking Compression Agent in
the System Agent window and then clicking Change Schedule on the Program menu..

What's next?
" I'm finished fine-tuning compression. Go back to the beginning.






